Lesson10

Epi Report

SUMMARY

This lesson is an introduction to using the Epi Report module. Use Epi Report to design and
generate reports containing Analysis output. Reports can also contain system variables and
graphics.

In this lesson, you will use data from the survey and output created in Lessons 1-9 to create a
sample report that contains some of your findings. Your report will contain frequencies, missed
days per condition, a line listing of conditions and missed days for a specified age, and the worst
month pie chart created in Lesson 6 Epi Graph.

Using the data tables you created in Lesson 1-9 and the graphs and maps, you could create a
comprehensive report to illustrate the need for asthma initiative funding in the region. For this
lesson; however, you will only use a fraction of the data to learn the Epi Report module and
create a basic report containing some of the findings.

To view a sample of the report you will be creating, you can open the Epi Report module, select
File>Open, and view either My Epi Report2. EPT or WMonth Report. EPT.

Length of time to complete: 1.5 hours Beginner
Getting Started with Epi Report

Overview of basic information to navigate Epi Report. Includes information on Report
Elements that can be added to your reports and/or updated from Analysis output.

Insert a Report Object

Use the Label and Drawing Tools options to insert a title and a line in your report. Learn to use
the Properties dialog box, customize text, and insert a System Variable.

Read Data and Create Elements

Use the output file Frequencies. XML to add frequency tables per condition to your report. Use
the Properties dialog box to change table settings.

Aggregate Data

Add aggregated sum and average of missed days of school data to your report Includes a
Practice Lesson.




Create a Line Listing Group

Use this element to access the Query Builder, and develop a line listing for children seven years
of age who attended School A and who had asthma.

Insert an Image
Use this element to insert the worst month pie graph you created in Lesson 6 Epi Graph.

Skills Review

Series of five questions designed to reinforce skills learned in the Epi Report lesson.

BEFORE YOU BEGIN

Complete Lesson 6 Analysis: Epi Graph.

Complete Lesson 7 Analysis: Exporting Files

WHAT YOU NEED

Wmonth Pie Graph.BMP or WMONTH GRAPH.bmp
Frequencies. XML

SymptomsByAge.mdb or SymptomsByAgeSample.mdb

FIVE GOALS

® Drag report elements on to the Epi Report workspace and to open the associated
Properties dialog boxes.

= Open an XML file created as Analysis Output and select data tables for inclusion to a
report.

= Insert aggregated and summarized data into a repott.
= Use the Query Builder to design a customized line listing for your report.
= Insert a graphic created in another program as part of your report.

Getting Started with Epi Report

The Epi Report tool is used to design and generate reports. Reports can contain elements
bound to data sources. The Epi Report module uses the . XML files generated by Analysis when



output is created. Report elements can include Analysis XML files, records lists, cell
replacement, groups, and aggregate data. Data analysis, through pivot tables, is also provided.

Reports are saved in the Epi Reports format with the extension of .EPT. When a report is
generated, the corresponding data source (which is an XML file) is accessed. The latest
information from the XML is displayed to the user during report generation. The user can select
individual data elements to appear in the report. When generating reports, queties are applied
to the specified data sources, and information is extracted and displayed. You can include
multiple tables, apply conditional filters, group data, and apply various aggregate functions on
the extracted data.




The Epi Report Workspace

Click Create Reports or select Programs>Create Reports to open the Epi Report module.

This is an example of the Epi Report Workspace:
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Navigating Epi Report

Elements added to a report are arranged in the Designer Window. Use the Epi Report main
navigation menu and the tool bar to edit text and resize tables. Use the Elements Command
Tree to insert data from Analysis, graphics, and text objects.

Navigation and Tool Bars

Use the File, Edit, View, Tools, Windows, and Help menus to complete standard tasks
associated with creating a report. This includes New, Save, Print Preview, Generate Report,
Undo, Copy, Paste, Zoom, Pagination, and Reload Analysis XML.

Use the Tool Bar to customize text and tables, Generate Reports, Preview the Template,
and Add Vertical Space to your report.

“Normal Z| [\Texdana zl [prt EI ?Brl U T E=E | IS EEV

|w = H| =

When text is selected in the report, the text formatting tool bar activates. Use these options to
change font style, size, appearance, color, and location. Numbering and bullet options are also
available. Use the W and H arrow boxes to resize tables and cells to specific sizes rather than
using the corner drag method.

ity
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Elements Command Tree

The Elements Command Tree provides you with the menu options to add data elements, text,
and graphics to a report. The tree is divided into four types of elements. Clicking one of the
elements will activate a pop-up option menu where you can select an output type (usually an
.MDB), or will allow you to drag the selected element onto the workspace and customize its
appearance.

Click the plus box next to each command to see all the available options for each heading. For
example, open the Insert Report Object heading by clicking the plus box. Under Insert Report
Object, you have the option to add a Table Shell, Image, Anchor, or Label to your report.
Objects and elements are added to a report using the drag and drop method. Objects and
elements are customized using the Properties dialog box associated with the object.




8- Insert Report Object
- Table Shell
- Image
- Anchor
" Label
& Drawing Tools
. wLine
- Insert Variable
& Permanent Variables
“ LANGUAGE
8- System Variable
i CurrentD ate
i CurrentTime
“ TemplatePath
8- Read Data and Create
$ Read Analysis Output
#- Field Aggregate
#- Line Listing Group
“ Pivot T able

Insert Report Objects includes Table Shell, Image, Anchor, and Label. Use Table Shell to
drag an empty table into the workspace. Image and Label allow you to place text or graphics
in the workspace. Anchor allows you to insert an HTML link.

Drawing Tools includes Line. Use Line to insert a line element as a graphic. Lines can be
resized and customized with new colors, styles, or widths.

Insert Variable includes Permanent or System type. Use these elements to insert the date
or time as a variable in your report.

Read Data and Create includes Read Analysis Output, Field Aggregate, Line Listing
Groups, and Pivot Table. Using these options allows you to select a project (MDB) and to
choose an output or routeout file and to drag and drop data into your report.
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Report Data

Types of output data you can add to reports using the Elements Command Tree.
Read Analysis Output

Use the Read Analysis Output command to include information from Analysis XML files.
Each XML file selected is added under the Read Analysis Output menu in the tree. Multiple
XML files can be opened. Data is added to the Designer window using the drag and drop
method. Each time the report is generated, the output files are updated to reflect changes made
in Analysis.

Field Aggregates

Aggregate functions (count, min, max. etc) can be applied for individual columns in the
database and the corresponding information can be included in the report. Aggregates are
calculated during report generation. Conditional filters can also be applied using the Query
Builder window. All formatting options are available.

Line Listing Group

Users can logically group related data using the grouping concept. A record-list is based on a
database query. Use the Query Builder for Line Listing Groups to select items that will appear
in the listing. If no fields are selected, a simple record list is created. If a group field is selected,
the records displayed appear as part of the selected group.

Once the query is formed, it is added to the Line Listing Group menu inside the Element
Command Tree. The Line Listing can then be selected, dragged, and dropped into the report.
Once added it can be customized with headers and footers by inserting rows at the top and the
bottom of the table listing. Formatting options like color, size, etc. can be selected for the items
in the table. The formatting options are applied during the generation of a report.

Pivot Table

Pivot tables can be embedded into reports for data analysis. Use the Query Builder to select
criteria to include in the pivot table.




Insert a Label

Use the Insert Report Object menu to create a title for this page of the report. The Label option
can be used to insert any kind of text into a report.

1.

9.

From the Epi Info™ main page, select File>Create Reports or click Create Reports.
Epi Report opens. The workspace opens to a blank template.

Click the plus box next to Insert Report Object in the Element Command Ttree. The box
expands to show the options available.

Left click and hold the option Label.

Drag and drop the word Label into the Designer window. This will be the title of your
report.

Highlight select the word Label by using your mouse to left click and drag over the word.
Use your keyboard to type over the word Label and enter a title Asthma Frequency Report.

Highlight the title text and use the Tool Bar to change the font style and size to one of your
choosing,.

IVerdana LI |18 pt LI

Click the Bold style button.

Ts

Use the Text color button to select a new colot.

10. Deselect the text by clicking anywhere inside the blank workspace area.

Your workspace should look similar to the following:
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» To see the workspace area in relation to the printed page, click the Page Area i
button. A blue dashed line appears around the workspace showing you where page
breaks for printing will appear. Click Page Area again to turn the option off. You
cannot edit the report while the Page Area feature is active. Use the Page Area option
as you add items to the page to ensure that your report elements are inside the printable
page area and to center items in relation to each other and the printable page area.

11. Select the title text you added to the page.

»  Use the mouse cursor to hover over the text until it turns into a black cross arrow El
icon, then click to select the text. Four white box handles will appear around the text
to show that it is selected. Text and tables can be resized by clicking and dragging any
of the white handles that surround them when they are selected.

EAsthma Frequ:ency Report -©

u]

12. Move the text to the top center of your workspace by hovering over the text until you see
the black cross arrow icon, left click, hold, and drag the title text to the new position on the

page.




Insert a Line

Use the Drawing Tools menu to drag and drop a Line into your report. Lines can be resized
and edited to act as dividers between sets of information.

1. Click the plus box next to Drawing Tools in the Element Command Tree. The box
expands to show the options available.

2. Select Line and drag it onto the page. The line should have the white bounding box
selectors surrounding it.

3. Click and drag the line under the title text.

4. Resize the line by hovering over the white selection handles. The cursor changes to a

hotizontal arrow = line.
5. Click and drag the line to resize it. You may have to do this on each end of the line.

6. While the line is selected, right click on the line to open the pop-up menu and select
Properties. The Properties- Line dialog box opens.

= Notice that the line color is gray.

{5, Properties - Line ' x|

Style Name I El

Alphabetic | Categorized |

Color 0x808080 ~|
Height 1

LineStyle Solid

Width 395

Color
Select the background color for the line

7. Click the drop-down box in the Color field. The color palette appears.
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8. Click a color block to select it as the line color.
9. Click OK. The line color changes.

10. Click the Height field.

11. Highlight the number 1 and type a 2 over it. This makes the line 2 pixels in height.

12. Press the Enter key on your keyboard to apply the change.

13. Click the Close X to exit the Properties- Line dialog box.

11



Insert a Variable

Use the Insert Variable menu to place a date, time, or file path inside your report.

1. Click the plus box next to Insert Variable in the Element Command Tree. The box expands
to show the options available.

2. Click the plus box next to System Variable to expand the menu.

3. Click and drag the variable CurrentDate to the upper left hand corner of the report page.
The date variable updates each time you generate the report to reflect the current date.

4. From the Tool Bar, click the Generate E icon. The generated report appears in a new
window.

The report page should look similar to the following:

151

File

@/ s 9

6/13/2005

Asthma Frequency Report

5. Click the Back icon to return to the workspace.
6. Sclect File>Save As. The Save Epi Report dialog box opens.
7. In the File Name field, type My Epi Report.

8. C(lick Save.
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Using Analysis Data

You can include output created in Analysis in your report data. Information added to the report
and updated in Analysis also updates when you generate the report with Epi Report. You want
to include frequency data for asthmatic conditions from the survey in the report.

1.

Click the plus box next to Read Data and Create in the Element Command Tree. The box
expands to show the options available.

= The Read Data and Create options allow you to add data created in Analysis to your
reports. Data can be updated in your report as changes are made in the Analysis

module.
Click Read Analysis Output. The Select an XML File dialog box opens.

Locate the EIHA Tutorial folder. Notice the Output. XML files in the EIHA folder. These
files were created when the Output. HTML files were created and contain the same results.

Look in: | 3 EIHA Tutorial -] « & ckEr
i _1downloads 2] OUTS90.xml @ ouTent xml =Jour
) 2 Frequencies. xml 2] ouTS91.Xml 2] ouTenz.xml Sout
Histary 2] ouTss1.xml 2 ouTs92.xml 2 ouTE03.xml &our
s 99 OUTS82.xml 2 OUTS93. xml 2 OUTE04. xml @ out
@ 99 OUTSE3. xml 2 OUTS94. xml 2 OUTE0S, xml @ ouTt
Desktop 2] OUTSS4, xml (2] OUTS95. Xl 2 ouTE0E. Xl “our
: 2] ouTSEs i 2] ouTsge. xml 2 ouTen7.xml 2 out
ﬁ 2] OUTSE6, xml 2] oUTS97 . xml 2 oUTE08. xml @ out
My Documents [ ESLSTLEES] 2 OUTS98. xml 2 oUTE09.xml @out
™= 2] ouTSEE. Xl 2] OUTS99.xml 2] ouTe10.xm & our
o 2] OUTS89. Xl 2 ouTenn.xml 2 ouTsll.xml @ ouT
My Computer
2 »

A < | i3
= File hame: I LI | Open I

My Network P...

Files of type: f (*xML) ~| Cancel
Z

Select the . XML file called Frequencies. This file was created by using the ROUTEOUT
command in Analysis.

Click Open. The Analysis Tables dialog box opens.

Select the table FREQ Asthmatic Conditions. You may have to scroll through the list to
locate the proper table.

Click the single arrow pointing to the Selected Commands field.




info Analysis tables a x|

Commands Selected commands
FREQ SchoolMum FREQ AsthmaticConditions
FREQ Gender

FREQ ‘Whonth

FREQ Bronchitis STRATAVAR = SchoolNum
FREQ Asthma STRATAVAR = Gender >>
FREQ Medication

FREQ Zip

FREQ AsthmaticConditions
FREQ Zip

FREQ SchoolMNum

<L

ERENERE

i Cancel |

8. Click OK. The Read Data and Create menu updates to show that the information you
selected from the XML file is available for use in your report.

& Read Data and Create
B Read Analysis Output
- &-Frequencies.xml
& FREQ AsthmaticConditions
i Field Aggregate
i Line Listing Group
“ Pivot T able

9. Click the plus box next to the menu item FREQ Asthmatic Conditions. The menu expands
to show all the table results in your . XML file.

&-Read Data and Create
5-Read Analysis Output
- Frequencies.xml
&-FREQ AsthmaticConditions
o Asthma
- 95% Confidence Intervals : Asthma
- Reactive Ainway Disease
- 95% Confidence Intervals : Reactive Ainway Disease
- Asthmatic Bronchitislor Wheezy Bronchitis
- 95% Confidence Intervals : Asthmatic Bronchitislor Wheezy Bronchitis
- Wheezing
.. 95% Confidence Intervals : Wheezing

*  Youare going to drag and drop the table results for the four symptoms onto the report
workspace.

10. Select, drag, and drop Asthma, Asthmatic Bronchitis, Reactive Airway Disease, and
Wheezing onto the report individually.



Do not drag the 95% confidence intervals.

The workspace should look similar to the following:
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y Epi Report.EPT] =18 x|
%% File Edit View Tools Windows Help =12 x|
jos@@ B s =mR- ~ B
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= —
&- Insert Report Object
& Drawing Tools lll[‘ FIPIFIFIFI[FI
- Insert Variable 1 Date
. Pemanent Varables Jineta Asthma Frequency Report
& System Variable —
&-Read Data and Create 3
- Read Analysis Output h
- Frequencies.xml — Asthma
E
& FREQ Asthma Bronchiis RAD Wh | g"‘mg{eﬂ“‘myff;?“ﬁ“g;em“
Asth ] 5 >
R , - O o 82625 100
95% Confidence Intervals : Asth | — Tota 800 100 100
Asthmatic Bronchitislor Wheezy ] o
95% Confidence Intervals : Asth ]
Reactive Ainway Disease > — 2
95% Confidence Intervals : Rear J P is or Wheezy arWlwezy ]
‘Wheezing ] =
95% Confidence Intervals : Whe | — g) 3?4 ég;g 1307 2
Field Aggregate : Total 800 100 100
Line Listing Group ]
Pivot Table T
] Reactive Airway Disease
= Reactive Airway DiseaseFrequencyPercentCum Percent
J ) 93 11625 11625
] 6] 707 88375 100
T Total 800 100 100
] Wheezing
] Wheezing FrequencyPercentCum Percent
— &) 99 12375 12375
3 [©] 701 87.625 100
1 Total 800 100 100
T — s - &
CAPS [INS  |NUM
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Editing Report Elements

Report elements can be edited using the Properties dialog box for the selected element type.

1. Select the Asthma table.

»  Selecting tables works the same way as selecting lines or text. Hover until you see the
black cross arrows and then click. The table will be surrounded by white bounding

boxes.
= De-select a table by clicking anywhere inside the workspace.
* Resize a table by click dragging the corners of the boxes.
2. Right click the selected table. The table menu opens.

3. Select Properties. The Properties- Table dialog box opens.

i Properties - Table x|

Style Name | :_I

Alphabetic | Categorized |

Backaground Color | | DxFFFFFF L]
Border Color Il 0000000

Border Size[Pixels) 1

Borders

Cell Spacing(Pixels) 0
Cell Thickness(Pixels) 0
Height i)
Width 310

Background Color
Select the backaround color for the table

= Table elements can also be edited separately. For example, if you place your cursor
inside a cell, you can edit properties for the row, column, or cell where your cursor is
placed. In each case, the title of the Properties dialog box changes to indicate which
part of the table you are editing.

*  When you drag a table into your report, the table borders appear in the workspace, but
not in the print preview or on the printed page. Borders must be applied to appear as
part of the report.
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4. Click inside the Borders field of the Properties-Table dialog box. A Browse button appears
in the field.

5. Click the Browse =< button. The Choose Border dialog box opens.

i~ Choose Border N x|

— Border

ceecesesespEree—-—-
1
'
'
'
[l
'
'
'
[l
1
[
- ————————— o o o
1
1
'
'
[l
1
'
'
1
1
'

Cancel Apply

6. Click each of the three horizontal borderlines.

7. Click each of the three vertical borderlines.

Click Apply.

9. Click OK. The selected table should have a visible black outline.

10. Click the Border Color field. A drop-down menu appears in the Border Color field.
11. Use the drop-down color palette to select a new color for the table border.

12. Click OK.

13. Select the Cell Spacing (Pixels) field.

14. Highlight the number 0 and type the number 7. Press the Enter key on your keyboard to
apply the cell spacing to your table.

17



# Practice

Select each of the tables in your workspace individually and apply the same edits to each of
them. This gives the tables in your project a consistent look.

Add a Border.

Change the Border Color.

Add Cell Spacing.

Your workspace should look similar to the following:

into Epi Report - [C:\Epi_Info\EIHA Tutorial\My Epi Report.EPT]

-(&] x|
% Fle Edt View Tools Windows Help =& x|
|oemad By me|klo~ |8
“ zl |TimesNewHoman 3 I‘IUpt 3 ‘ B r U | g T ‘ === ‘
|wlm o wlE A
&- Insert Report Object
B s L
erp——— {Date} =
B Asthma Frequency Report
Style Name vl
i
Alphabetic I Categorized | e
Background Color || OxFFFFFF =l A N Cum
Border Color Il 0:cooo00 AHENES TN percent
Border Size[Pixels) 1 + o1 11375 |11.375
Boders S 83.625 100
Cell Spacing[Pizels) 1 Motal [300 100 100
Cell Thickness(Pixels) 0
Height 75
Width 232 Asthmatic Bronchitis or Wheezy Bronchitis
Asthmatic Bronchitis or Wheezy e Cum
Bronchitis = "] Percent
+) 86 1075 |10.75
5 14 B9.25 _|100
[Total 800 100 100
Reactive Airway Disease
Reactive Airway |- ercent Cum
Background Color Disease S Percent
Select the background color for the table +) 93 11625 11625
) 707 88.375 (100
] [Total 800 100 100
— o
g Wheezing
Wheezing, ercent] | CUM
= Percent
] 4 99 12375 |12.375
] = 701 87.625 (100
=3 Total 300 100 Jioo
4 | 3 =
CAPS [INS | NUM
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Change Table Fonts

In this section, you will select the text inside each table and choose a new font.

1. Left click and drag to highlight the text inside the Asthma table.

I < . E
7 e R |
@ @ e T |

T o o0 NN oo 0

2. TFrom the Tool Bar, use the Font drop-down to select a new font.
* Verdana, Arial, or Tahoma are good choices for this report.
» Leave the Font size at 10.
» Ifyou need to move a table, select it, and use the click and drag method.

= If you need to add more space at the bottom of your page, click the Vertical Space

EN

button.

3. Change the font in each of your tables to match.

19



Resize Tables

Tables and report elements can be resized by click dragging the bounding boxes, using the Tool
Bar options, or by using the Properties dialog box.

1.

2.

10.

11.

Select the Asthmatic Bronchitis table.
Right click and select Properties from the menu. The Properties- Table dialog box opens.

*  You can see the size of the table in the Tool Bar or the Properties-Table dialog box.
wlns o H[s =

Height 75
Width 418

Change the Width of the table to 500.

Press Enter on your keyboard to apply the changes.
Change the Height of the table to §0.

Press Enter on your keyboard to apply the changes.
Change the Width and Height of each table in the report.
Re-position the tables as needed.

Save the report.

Click Generate to view the report.

From the generated view, click Print Preview to see how the printed report will
look.

The report should look similar to the following:
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/23 Print Preview

6/14/2005

@)+ - el a1 = S [ @[T00% ]| e | e

Asthma Frequency Report

Asthma

Asthma

Frequency

Percent

Cum Percent

Yes

91

11.375

11.375

Mo

709

68.625

100

[Total

800

100

100

Yes

86

Frequency|

Asthmatic Bronchitis or Wheezy Bronchitis
Asthmatic Bronchitis or Wheezy Bronchitis

Percent| Cum Percent

10.75

10.75

No

714

89.25

100

[Tatal

800

100

100

[Yes

Reactive Airway Disease

Reactive Airway Disease Frequency
93

11.625

Percent

11.625

Cum Percent

Mo

707

88.375

100

[Total

800

100

100

Wheezing

Wheezing |

Frequency

Percent

Cum Percent

[ves [EE]

12.375

12.375

o 701

87 .625 100

[Total

300

100 100

Hstart| | @ G © D@ >|| inbox-ic...| Hepitnto

FhEpi Report ... | E]Lesson 10... | @B Fulshot....

Page 1of 1

-

SEIGODE  aaeem

12. Click Close to return to the generate window.

13. Click Back to return to the workspace.
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Insert a New Page

You want to create a new page that contains data on county absenteeism. In this section, you
will insert a page break after the frequency tables. In order to insert pages, you must have the
Pagination Settings activated in the report.

1. Use the Enter key, Vertical Space button, or mouse to move your cursor underneath the
tables in the current report.

2. Sclect Tools>Pagination. The Pagination Setting dialog box opens.

Pagination Setting L. i |

Select a pagination setting for the template. Please read the help file to learn
about the benefits of each setting.

" Pagination On " Pagination Off
Set Default
Setting DK LCancel Help

3. Click the Pagination On radio button.

4. Click OK

5. Place the cursor where you want a page break to occur.
6. Right click to activate the pop-up menu.

7. Sclect Insert Page Break. A blue dotted line appears.

8. Move your cursor underneath the blue line. This is the top of page two.
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Insert a Table Shell

In this section, you will add a blank table to your report and format the table so that aggregated
data can be added to cells.

1. Open the Insert Report Object menu.

2. Seclect and drag a Label under the blue page break line.

3. Highlight select the Label and title it County Absenteeisms.

4. Seclect the text and use the Tool Bar to select 2 new Font, Size 18, Bold, and Undetlined.
5. From the Insert Report Object menu, select Table Shell.

6. Click and drag a Table Shell onto the report. Place it under the new title so it appears on
the new page.

7. Click in the first table cell and type the text Sww of Missed Days in the County.
8. Click inside the second cell and type the text_Average of Missed Days per Student.
9. Right click in the third cell/column and from the menu select Delete Col.

10. Right click in the third row and from the menu select Delete Row.

Sum of Missed Days in  Awverage of Missed Days
the County pet Student
11. Select the table.

12. Resize the table so that the text appears without the wrap.
= Use the corner drag method, the Properties-Table dialog box, or the Tool Bar options.

Your table should look similar to the following.

Sum of Missed Days in the County  Average of Missed Days per Student

23



Insert Aggregate Data

Aggregate or summarized data can be included in reports. Aggregate types available in Epi
Report include count, minimum, maximum, percent, sum, and average. In the asthma report,
you want to include the total and average numbers of missed days in the county due to breathing
problems.

1. From the Elements Command Tree open the Read Data and Create menu.

2. Click Field Aggregate. A pop-up menu appears with the option to select ODBC or MDB.
3. Select MDB. The Select Access Database window opens.

4. Locate the EIHA Tutorial folder and select Asthma Fina. MDB.

5. Click Open. The Select Tables dialog box opens.

{5 Select Tables : x|

Available T ables Tables to Show

alb_race -
Albany_Age I
Albany_Eth

Albany_Gender

Albany_race

Albany_Sex

asthmafreq

asthmazip

brfss

brfss2001

Cntasthma

chttest

Countasthma

Countdsthma2 b
CountBronchitis

days

DaysCntT able

DaysTable

daysvar

dayszip

MissedDays ;I

[~ Show View T ables [~ Show Code Tables

0K I LCancel |

6. From the Available Tables field, scroll through the list to find the table called
PrelnterventionSurvey.

7. Select the table.
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8. Click the single arrow button. The table appears in the Tables to Show field.

9. Click OK

10. Click the plus box next to PrelnterventionSurvey to view the available variables.

85-Read Data and Create
B Read Analysis Output
&- Field Aggregate

g Tables
5- PrelnterventionSurvey

& Age
& Asthma
& Bronchitis
& ChildFirst
& ChildLast
#- Cough
& Dailymed
#-DOB
& Emergency
- Gender
- Grade
&#-lIHome
- Medication
#- MissDays
& MissSport

& C:\Epi_InfoAEIHA Tutorial\Asthma Survey 2005.mdb

11. From the PrelnterventionSurvey list of variables, click the plus sign next to MissDays. The

list of available aggregates appeats.

- &-MissDaps
-~ Count
- Minimum
- Maximumn
- Percent
- Sum
- Average

12. Select Sum and drag it to the first cell, under the heading Sum of Missed Days in the

County.

13. Select Average and drag it to the second cell under the heading Average of Missed Days

per Student.

{Prelnterventiond

Sum of Missed Days in the County | Avwverage of Missed Days per Student

{Prelnterventions
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14. Click Generate to see the results appear in the new table.

15. Click Print Preview from inside the Generate Page to see the report on the two pages.
16. Close the Preview window.

17. Click Back in the Generate window to return to the workspace.

18. Place the cursor inside the heading Sum of Missed Days in the County and right click.
19. From the pop-up menu, select Row Properties. The Properties- Row dialog box opens.
20. Sclect the Background Color field.

21. Use the Color drop-down to select a color.

22. Click OK. The color is applied to the selected Row of your table.

Sum of Missed Days in the County  Average of Missed Days per Student

{Prelnterventiond {Prelnterventiond

23. Highlight select the text Sum of Missed Days in the County and Average of Missed Days
per Student.

24, Use the Tool Bar to select a new Font, Size 10, and Bold.

25. De-select the text and select the table.

26. Resize the table if necessary.

27. Right click the table and open the Properties- Table dialog box.

28. Add a border to the table.

29. Sclect and drag the table to the top center of your new report page under the title label.
30. Save your report.

31. Generate the report.

32. Print Preview the report.

Page 2 should look similar to the following:
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/23 Print Preview

pint. | &) | % & pagel o2 =+ | @ @ [100% ~]| He | ciose

County Absenteeism

Sum of Missed Days in the
County

Average of Missed Days

per Student

3014

3.7675

Hstart|| | ] @ G © D@ >|| Binbox-pic... | Etesson 10... | Fhepireport ...| Fhepitnfo

| @Bruishote....

Page 2 of 2

-

BEaHO@ s

33. Close the Print Preview window.

34. Click Back from the Generate window to return to the workspace.
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# Practice

From the Insert Report Object menu, select and drag a new table shell onto the report.

In the first cell of the table shell, right click and select Insert Row. Add rows to the table until
you have 5 rows.

In the first cell of your table, type Syzptoms.

Fill in the first column of the table with the Symptoms from the survey. Your table should look
like the following,.

Symptoms
Asthma
Bronchitis
Reactive Airway
Disease
Wheezing

In the first row of the second column, type Tozal Missed Days per Symptom.
In the first cell of the third column, type Average Missed Days per Sympton.

Under Field Aggregate, right click on Tables under the Asthma Survey Final project.

=-Field Aggregate
. 8-CAEpi_Info\EIHA Tutorial\dsthma Final.mdb
#- T ables

Select Edit Tables. The Select Tables dialog box opens.

From the Select Tables dialog box, use the single arrow to add the individual tables MDAsthma,
MDBronchitis, MDRad, and MDWheeze to the Tables to Show section.

Click OK. The list of available tables under the Field Aggregate menu updates.

From the Field Aggregate menu, click the plus box next to each MD table to open the

selections.
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&-Read Data and Create
#-Read Analysis Output
- Field Agaregate
EB C:AEpi_Info\EIHA Tutorial\Symptoms by Age.mdb
8- CAEpi_Info\EIHA Tutorial\Asthma Survey 2005.mdb
&-Tables
- PrelnterventionSurvey
é-MDAsthma
- & COUNT
- - MissDaps
. @8- VARNAME
EI -MDBronchitis
- & COUNT
- - MissDaps
@8- VARNAME
= -MDRad
- & COUNT
- - MissDaps
8- VARNAME
5-MDWheeze
& COUNT
& MissDaps
- VARNAME

Open the variable MissDays under each table. The list of aggregate values appears.

Drag the word Sum into the Total of Missed Days per Symptom column next to the
corresponding symptom.

Be sure you are dragging the Sum onto the cell that matches the symptom.

Your table should look like the following:

Svmptoms Total Missed Days per Average Missed Days
yop Symptom per Symptom
Asthma {MDaA sthma.sMis
Bronchitis {MDBroncl*ﬁtis.s
Reactive Aitway | (\DRad sMissDa
Disease ~
Wheezing {MDWheeze.sMi

Drag the word Average into the Average of Missed Days per Symptom column next to the
corresponding symptom.

Your table should look like the following:
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T — Total Missed Days per  Average Missed Days
yp Symptom per Symptom
Asthima { MDA sthma.shis {MDA sthma. alis
Bronchitis {MDBronchitis.s {MDBronchitis.a
Reactive Aitway | I7\DRad.sMissDa = {MDRad.aMissDa
Disease - et
Wheezing {MDWheeze.sMi {MDWheeze.ali

Edit the table to make it look like the Sum of Missed Days table you created earlier in this

lesson.

Add a cell color to the headings.

Add a border to the table.

Change the font size and style to match the Missed Days table.
Resize the table.

Center the table under the Missed Days table.

Save your report.

Generate the report and then Preview the report.

The report should look similar to the following:
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x|
[&]| % & pagele o4 = » |G & [100% |

County Absenteeism

‘Sum of Missed Days in the County Average of Missed Days per Student

3014 3.7675
Symptoms Total Missed Days per Symptom |Average Missed Days per Symptom
Asthma 99 11
Bronchitis 110 10
Reactive Airway Disease 105 10.5
Wheezing 112 9.3333333333

| » I_‘
S Epi Report - [C...| @@Fuishot6.01 ... | [SIIDEH D@ z:42em

<

Starl:l“ @ G50 ”“ [Elinbox - Micros... | F&Epi Info | B Lesson 10 Epi ...
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Create a Line Listing Group

Line listings are record lists based on queries. Use Epi Report to create the query and then drag
and drop the listing into your report. For the report, you will be creating a line listing of children
with asthma by age group and school.

1.

2.

Insert a page break under the last table on the page.

Drag a Label to the new page.

In the Label area, type the page name Absenteeisn: for School A- Age 7.
Change the Font Style, Size 18, Bold.

From the Element Command Tree under Read Data and Create, select Line Listing
Group.

From the pop-up selector, click Select an MDB File. The Select Access Database window

opens.
Locate and select the SymptomsByAge.mdb. The Query Builder window opens.

= This projectis the one you created in Analysis to hold the line graph data for symptoms
by age.

= If you do not have the Epi Graph project, use the SymptomsByAgeSample.mdb
provided.
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iafo Query Builder x|
Query Name

Read I Re_lalel Sglectl groupl Sort I

Available ltems Available Fields Fields to Show
ageandsymptom

[] AlSymptoms

[] Programs

>>

&l |5 15 E
[« =

<L

I | — 2|

[~ ShowView Tables [~ Show Code Tables

Top N Value: I_ ﬁ
Top Percent I~

| | 2 < | j3|

View Query I Clear Query l OK LCancel |

8. TFrom the Available Items field, click the checkbox next to AllSymptoms. The Available
Fields section populates.

9. Select the SchoolNum field, and click the single area to move it to the Fields to Show
section.

10. Add the following to the Fields to Show section:
= Age, Gender, MissDays, Asthma, Bronchitis, RAD, and Wheezing.
11. In the Query Name field at the top of the window, type SyzptomsList.

Your Query Builder dialog box should look like the following:
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iafo Query Builder =
Query Name

Read I Flelalel Sglectl §roup| Sort I

I | — 2|

[~ ShowView Tables [~ Show Code Tables

Top N Value: I— ﬂ
Top Percent o

2] — paf K]

Available [tems Available Fields Fields to Show
[] ageandsymptom AllISymptoms].[DOB] [AlISymptoms].[SchoolNum]
v mptoms [AlISymptoms]. [Medication] [AlISymptoms]. [Age]
[] Programs [AlSymptams].[StudentID] [AlIS ymptoms]. [Gender)

[AllSymptoms]. [&sthma]
[AllISymptoms]. [Bronchitis]
[AllSymptoms]. [MissDays]
[AllSymptoms).[RAD]
[AllISymptoms]).[wheezing)

[~ Treat as Yes/No

€ 1=

|

View Query | Clear Query |

x|

LCancel I

12. Click the Select tab. The Select Criteria options appear.

iato Select Criteria =

Query Name

lS ymptomsList

Eeadl Relat §roup| Sort I

Field Name Operator Value

| [8lISymptoms] [ge] = - = |

ADD Criteria I List Possible Values

Criteria

<]

View Query Clear Query

LCancel I
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* To narrow down the listing in this example, you are going to create a line listing of
students from School A who answered Yes to Asthma and equal seven years of age.

13. From the Field Name drop-down, select [AllSymptoms].[SchoolNum]
14. From the Operator drop-down, select =.

15. Click List Possible Values.

16. From the Value drop-down, select A.

17. Click ADD Ciriteria. The Criteria field populates.

= Use the same series of steps to select students who answered Yes to Asthma, and add
their criteria. Hint: Yes, appears as True in the Query Builder.

»  Use the same series of steps to select the students who are seven years of age, and add
their criteria. Hint: Remember to change the Operator drop-down selection.

= If you make a mistake and add the wrong criteria, highlight select it in the Criteria field
and press Delete on the keyboard.

The Select Criteria options should look like the following:

iato Select Criteria x|
Query Name

Eeadl Relate Select I groupl Sort I

Field Name Operator Walue

l [BlISymptoms] [Asthma] _VJ I = L’ ITrue{ Z]
AND into Ciiteria OR into Ciiteria | List PossibleValles |

Criteria

[BlISymptoms].[SchoolNum]= ‘&' _:J

And [alISymptoms]. [Asthma]= True
And [AlISymptoms]. [4ge]= 7

. |
View Duery | Clear Query | oK | LCancel |

18. Click OK. The Line Listing Group menu now contains the SymptomsList Query you
created.
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19. Click and drag SymptomsList to the work area on page three.

»  Resize the table using the bounding boxes.

= Use the Properties- Table box to add borders. When you add a border to a Line Listing
there will be an extra drop-down menu in the Choose Border dialog box. Use the drop-
down to add borders to the Header and the Body of the table.

*  Use the Tool Bar to change the font style.

= Use the Tool Bar to change the Heading Fonts to Bold.

The report workspace should look similar to the following:

fato Epi Report - [C:\Epi_Info\EIHA Tutorial\My Epi Report2.EPT]
% Fle Edit View Tools Windows Help

=181 x|

|loFma B s me ko~ B

SETE

“ zl |Times New Roman

S Z|= 2 o5 |s

I
[}
1]
11
({1
h
|
5
(|

| I N |

& VARNAME
&-MDBronchitis
& COUNT
&-MissDays

Count
Minimum
Maximum
Percent
Sum
Average
& VARNAME
MDRad
& COUNT
&-MissDays
Count
Minimum
Maximum
Percent
Sum
Average
& VARNAME
MDWheeze
& COUNT
&-MissDays
Count
Minimum
Maximum
Percent
Sum
Average
- VARNAME
8- Line Listing Group

SymptomsList
Pivot Table

K |

- CAEpi_InfohEIHA Tutorial\Symptor

|

v

l;|

N

1
1
1
o
1
1

Absenteeism for School A- Age 7

iSchoolNum |Age [Asthma [Bronchitis |Gender [MissDays [RAD

‘Wheezing

<SchoolNums |<Age> [<Asthmaz |[<Bronchitis> |[<Genders> [<MissDays> [<RAD>

l<Wheezing>

CAPS |INS  [NUM

-

20. Generate and Print Preview the report to see page breaks and tables.

21. Close the Print Preview window.

22. Click Back in the Generate window to return to the workspace.

23. Save the report.



Insert an Image
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For this report, you want to insert the worst month for asthmatic conditions pie graph you
created in Analysis into a new template page. The graph will look best printed in a landscape
style, so before inserting the image, you will use the Page Setup options.

1. Click the New Blank Template

O

icon to create a new report.

2. Seclect File>Page Setup. The Page Setup dialog box opens.

3. From the Orientation section, select the Landscape radio button.

4.

~N

ioc Page Setup i

X

— Paper Size

Available Sizes [{RRE]

— Page Header and Footer

Test to be displayed in the Header

[tbPage &p of &P

Test to be displayed in the Footer

[tutbtd
— Drientation — Marains (Inches)
{* Potrait Left I0~5" ﬁ Right ID‘5" il‘
{" Landscape Top |0.5" ﬁ Bottom (05" _:_j
oK Cancel l

= Notice the text inside the Page Header and Footer Section. Keeping this text will add
page, date, and file location to your printed page.

* To remove this pre-set information, select the text in the Text to be displayed in the
Header and Text to be displayed in the Footer fields and press Delete on the keyboard.

Click OK.
Open the Insert Report Object menu.

Select Image.

Drag Image onto the new report workspace. The Select an Image window opens.
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8. From the Files of type drop-down menu, select .BMP Files. All the bitmap files in your
EIHA folder appear in the file section.

9. Select the WMonthPieGraph.bmp you created in the Epi Graph Lesson or select the
sample graph WMonthPie2. BMP from the download folder.

10. Click Open. The Worst Month for Asthma pie graph appears in the report.

11. Click the Page Area icon.

12. Scroll to the right and notice the page breaks in the middle of your graph.

13. Turn off the Page Area icon.

14. Select the graph. Bounding boxes appear around the graph.

15. Click and drag the image to the top left of the page.

16. Right click and select Properties. The Properties- Image dialog box opens.

17. In the Width field, type a number to resize the image to fit your computer window.

18. Press Enter on the keyboard. This resizes your graph slightly so that it fits into the Page
Area.

From the Generate>Print Preview window, the report will look similar to the following:
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/23 Print Preview

pin. [ @]« « paefi a1 2 ¢ [R @[5 ]| ek | e 7

‘Worst Month for Asthmatic Conditions

November 8.7%
Deeenboer 3.8%
™ §

X 18.6% Oclober

-

February 7.7%
S 7

March 5.7%

4.8% hnniary
April 6.7%,

Mey 5.2%~

- ’ e
June 5.7% ",
24.2% September

/
July 5.7%
August 6.7%

| Shepireport-[ci... | [@GEDDR  w0apm

Hstart| | ] @ G © D@ || inbox - Microsof...| EjemHaTFormat.d.. | g8Fulshot 6.01 pr...| Fhepitnfo

19. Select File>Save As. The Save Epi Report window opens.
20. In the File Name field, type WMonth Report.
21. Click Save.

22. Close Epi Report.
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Skills Review

Place a checkmark next to the correct answer for each of the following questions. Refer to
Appendisc D Skills Reviews Answer Key for further details.

1. Which Analysis Output files are accessible by Epi Report?
[ JHTML
[ XML
[ JASP
2. To view a report with complete data included, click what button?
[]Add Vertical Space
[ ]Generate Reports
[ |Preview the Template

3. Aggregate data can be added to reports from the Read Data and Create menu.

[ JTrue
[ JFalse
4. Line Listing groups can be customized from which dialog box?
[ ]Query Builder
[ |Print Preview
[ |Properties
5. What Report Object element is used to insert a graphic into a report?
Dlmage
|:|Object

[ ]Generate



Lesson Complete!

WHAT YOU LEARNED

How to
= Insert textand line elements into a report template.
=  Use the Properties dialog box to customize inserted elements.

= Insert Analysis XML output into a report.

= Insert Aggregate Data from an Epi Info™ project into a Table Shell.

* Inserta Line Listing Group based on data tables created in Analysis.

* Insert an Image you created in Epi Graph.
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